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CHAPTER SIX : FORMATTING DOCUMENTS

You can format entire documents in much the same way you can format paragraphs. The same basic
concepts you learned in Chapter Five, such as indenting and adding backgrounds, can be applied on a
larger scale to the pages in a document.

This Chapter Will Include:

Adjusting Page Margins

Landscape View

Adding Page Borders and Backgrounds
Applying Themes

Using Templates
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Adjusting Page Margins

Page margins can be changed to allow you more or less space for text in a document. By default, every
new Word document has 10 margins on all four sides.

To change page margins, follow these steps:

1. Gotothe Page Layout tab and find the Page Setup group . Click the Margins icon.
2. In the menu that appears, choose a margin setting.

Page Layout

3 Ij = Breal
=) £ Line
Margins|Orientation Size Columns
- - - - hie H'_'.I'F'}'
Mormal
Top: 1" Bottom: 17
Left: 1" Right: 1"
N —
Marrow
Top: 0.5" Bottom: 0.57
Left: 0.5" Right: 05"
=~
Moderate
Top: 1" Bottom: 17
Left: 0.75" Right: 0.75"
Wide
Top: 1" Bottom: 1"
Left: 2" Right: 2"
]
Mirrored
Top: 1" Bottom: 17
Insice: 1,257 Outsicde: 1"
Office 2003 Default
Top: 1" Bottom: 1"
Left: 1.25" Right: 1.25"
Custom Margins...

3. You can also define your own margins by clicking Custom Margins , which opens the Page
Setup Dialog Box
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Landscape View

Landscape View changes the width of the margins, making the left/right margins shorter and the
top/bottom margins longer.

To change to landscape view, follow these steps:

1. Go to the Page Layout tab and find the Page Setup group . Click the Orientation icon and
select Landscape from the menu that appears.

2. Note that all four margins will adjust to comply with the new view (typically, the left/right and
top/bottom margins will switch).

The Sullivan University System

The Sullivan University System Is a joining of three schools-Sullivan University, Spencerian College, and Loutsville

Technical Institute-under one name. The Sullivan University System marks the first time a public school has

joined with two private schools to create a unique leaming system. Students can use the Sullivan University

System to obtain a strong education from three different areas of learning, without having to commute long
distances between each college. All three colleges have different benefits that will help enhance the leaming a Sullivan
University System student receives during the time they are enrolled at the colleges.

Sullivan University

Sullivan University, the largest private college in Kentucky, has campuses in Louisville, Lexington, and Ft. Knox. Sullivan
also has a world-renowned culinary school located near the Louisville campus. Sullivan University promotes a "career-
first" curriculum, with many students eaming their degrees in as few as 9 months, Students attend classes Monday-
Thursday, with Friday being a "plus” day where students can receive one-on-one assistance from faculty members.

Spencerian College

Spencerian College has campuses in Louisville and Lexington, and offers education for only those careers in demand.
These programs indude Graphic Design, Computer Aided Design, Health Sciences, and Business. Spencerian has classes
Monday-Thursday, with Friday being a "plus" day for students to obtain one-on-one assistance with faculty members.
With a hard work ethic and dedication to their studies, students can enter the work force in as little as 6 months,

Louisville Technical Institute

Louisville Technical Institute is Louisville's #1 university for programs in Graphic Design, Interior Design, Computer Aided
Design, Robotics, and more. LTI offers classes Monday-Thursday, with Friday available for one-on-one assistance.
Dedicated students can earn a degree from LTI in as [ittle as 9 months.

Adding Page Borders and Backgrounds

You can add borders, backgrounds, and watermarks to a document to draw attention to it. Note,
however, that background images will not print by default unless you specify such in the Print Dialog
Box (see Chapter One).

To add a page border, follow these steps:

1. Click the Page Border icon in the Page Background group on the Page Layout tab.
a. You can also open the Borders menu in the Paragraph group on the Home tab and
click Borders and Shading . In the dialog box that opens, click the Page Border tab.
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2. The options here are essentially the same ones you saw when applying borders to a paragraph in
Chapter Five; the only addition is the Art box at the bottom of the window. Here, you can choose

different border images not available when adding borders to par agraphs.
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3. When you are done, click OK.
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The Sullivan University System

Technical Institute-under one name. The Sullivan University System marks the first time a public school has

joined with two pnvate schools to create a unique leaming system. Students can use the Sullivan University

System to obtain a strong education from three different areas of leaming, without having to commute long
distances between each college, All three colleges have different benefits that will help enhance the leaming a Sullivan
University System student recelves during the time they are enrolled at the colleges.

l The Sulltvan University System is 3 joining of three schools-Sullivan University, Spencerian College, and Loulsville

Suliivan University

Sullivan University, the largest private college in Kentucky, has campuses in Louisville, Lexington, and R Knox. Sullivan
also has a world-renowned culinary school located near the Louisville campus. Sullivan University promotes 3 “career-
first" cumriculum, with many students eaming their degrees in as few as 9 months. Students attend classes Monday-
Thursday, with Friday being a "plus” day where students can receive one-on-one assistance from faculty members,

Spencerian College

Spencenian College has campuses in Loulsville and Lexington, and offers education for only those careers in demand.
These programs Iinclude Graphic Design, Computer Alded Design, Health Sciences, and Business. Spencenan has classes
Monday-Thursday, with Friday being a "plus™ day for students to obtain one-on-one assistance with faculty members.
With 3 hard work ethic and dedication to their studies, students can enter the work force in as little 3s 6 months.

Lousville Technical Institute

Louiswille Technical Institute Is Louisville’s #1 university for programs in Graphic Design, Interior Design, Computer Alded
Design, Robotics, and more. LTI offers classes Monday-Thursday, with Friday avallable for one-on-one assistance.
Dedicated students can eam a degree from LTI in a5 little a5 9 months.

To add a page background, follow these steps:

1. Return to the Page Background group in the Page Layout tab and click the Page Color
icon.
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2. You can select a color from the list here. To browse the full list of colors, click More Colors .

3. You can also add Fill Effects to your background. Click Fill Effects to open the Fill Effects
Dialog Box . There are four tabs here, each with different options .

a. Gradient : allows you to select up to two colors and change the way they blend
together.

b. Texture : allows you to select a preformatted texture from a list.

c. Pattern : allows you to select a background pattern from a list. You can also change the
colors of the pattern in this tab.

Picture : allows you to select a picture saved on your computer to add as a background.

Fill Effects Fill Effects ? X

[Gradent || Texture | Pattern | Picture Gradient | Texture | Pattern | Picture |
Colors Texture:
(2 One color Preset colors:
() Twea colors Caybreak w
(&) Pregat

Trafsparsncy

Fromz

To:

Shading styles Warianks

() Herigontal - |
(O Yeatical

() Diaganal up

) iagonal down

(%) Erom corner

() From center = u

|

Lo [ conce ] o

4. To save your changes, click OK.
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The Sullivan University System is a Joining of three schools-Sullivan University, Spencerian College, and Louisvilie

Technical Institute-under one name. The Sullivan University System marks the first time a public school has

joined with two private schools to create a unique leaming system. Students can use the Sullivan University

System to obtain a strong education from three different areas of leaming, without having to commute long
distances between each college. All three colleges have different benefits that will help enhance the leaming a Sullivan
University System student recelves during the time they are enrolled at the colleges.

Sulivan University

é The Sullivan University System

Sullivan University, the largest private college in Kentucky, has campuses in Louisville, Lexington, and R. Knox. Sullivan

also has a world-renowned culinary school located near the Louisville campus. Sullivan University promotes 3 “career-
first” cumiculum, with many students eaming their degrees in as few as 9 months. Students attend classes Monday-
Thursday, with Friday being a “plus” day where students can receive one-on-one assistance from faculty members,

Spencerian College
Spencerian College has campuses In Loulsville and Lexington, and offers education for only those careers in demand.
These programs include Graphic Design, Computer Aided Design, Health Sciences, and Business. Spencerian has classes

Monday-Thursday, with Friday being a “plus™ day for students to obtain oné-on-one assistance with faculty members.

With 3 hard work ethic and dedication to their studies, students can enter the work force in as little as 6 months.

Lousville Technical Institute

Loutswille Technical Institute Is Louisville's #1 university for programs In Graphic Design, Interior Design, Computer Alded
Design, Robotics, and more. LTI offers classes Monday-Thursday, with Friday avallable for one-on-one assistance.
Dedicated students can eam a degree from LTI in as litthe as 9 months.

To add a watermark, follow these steps:

1.

In the Page Background group  on the Page Layout tab, click the Watermark
opens a menu with pre-customized watermarks. You can select any from the list here, or click
Custom Watermark  to make your own watermark.
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To add a picture watermark, check the circle next to Picture watermark
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, you can select either a picture watermark or a text

and then click Select

Picture . A window will open where you can choose a picture saved on your computer to add as

a watermark.

To add a text watermark, check the circle next to Text watermark

fields.

and fill in the appropriate



© Hannah Stoltz

Printed Watermark @E|

) Mo watermark,
) Picture watermark:

(%) Text watermark.
Language: |English (U.5.) -
Tesk: The Sullivan University System W
Fonk: Times Mew Roman W
Size: Auta hd
Color: b d Sermitransparent
Layaouk:

| apply || ok || Close

5. To preview your watermark, click Apply . The dialog box will remain open if you need to make
additional changes.
6. When you are finished, click OK.

Applying Themes

Microsoft Word comes with several themes that can be applied to a document. These themes include
header styles, fonts, and text colors. However, if you have not specified header styles already in your
document, they will be unaffected when a theme is used. Themes can be applied to a new or saved
document; however, the only way to preview a theme is to apply it to a previously existing document. In
addition, themes cannot be used in Compatibility Mode.

To apply themes, follow these steps:

1. Onthe Page Layout tab, find the Themes group and click the Themes icon.
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— Fonts =
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2. This opens a menu with the different themes available. Hover your mouse over each theme to
preview it in your document. Note that the more you have used header styles, shading, and
colors in general, the more change you will see when previewing a theme. If you have used little
or no color or styles, you wonod6t see much change.

3. Click a theme that you want to apply. In the Themes group, you can also change the color
scheme and fonts, or you can create your own color and font styles.
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The Sullivan University System

The Sullivan University System Is a joining of three schools-Sullivan University,

Spencerian Coliege, and Louisville Technical Institute-under one name. The
Sullivan University System marks the first time a public school has joined with two private
schools to create a unique learning system. Students can use the Sullivan University System
to obtain a strong education from three different areas of learning, without having to
commute long distances between each college. All three colleges have different benefits
that will help enhance the learning a Sullivan University System student receives during the
time they are enrolled at the colleges.

Sullivan University

Sullivan University, the largest private college in Kentucky, has campuses in Louisville,
Lexington, and Ft. Knox. Sullivan also has a world-renowned culinary school located near the
Louisville campus. Sullivan University promotes a “career-first" curriculum, with many
students earning their degrees in as few as 9 months. Students attend classes Monday-
Thursday, with Friday being a “plus" day where students can receive one-on-one assistance
from faculty members.

Spencerian College

Spencerian College has campuses in Louisville and Lexington, and offers education for only
those careers in demand. These programs include Graphic Design, Computer Aided Design,
Health Sciences, and Business. Spencerian has classes Monday-Thursday, with Friday being
a "plus” day for students to obtain one-on-one assistance with faculty members. With a hard
work ethic and dedication to their studies, students can enter the work force in 3as little as 6
months.

Using Templates

Templates determine the basic structure of a Word document, including the format and what features
can be applied to it. Word comes with many built -in templates that can be customized.

To use a template, follow these steps:

1. Click the Office Button and then choose New from the menu that appears.

2. In the New Document Dialog Box , scroll through the list of templates available. Click
Installed Templates  to see the templates that have already been installed on your computer.
You can also choose to install new templates by clicking on any category under Microsoft
Office Online

3. ClickCreate to apply the selected template.

10
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4. The template will open as a new document. You can customize any part of the template by
adding text or by changing the colors and font.
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